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1. Getting Started 

 

Welcome 

 
Thank you for purchasing HandScan, a cutting-edge, automatic 

hand size measurement system. It provides easy, cost-effective and 

accurate hand measurements as a result of advanced technologies 

in both digital image processing and anthropometry. We are 

confident that HandScan will help you increase the efficiency and 

productivity of your work.  

 

System Features and Benefits 

 

HandScan system version 2.1 has the following features: 

 HandScan is an image-based hand size measurement system, 

currently providing nine hand dimensions (hand length, palm 

length, hand breadth, middle finger width, and five finger 

lengths). 

 HandScan automatically detects whether right or left hand is 

being measured. 

 All the hand dimension data can be transferred to an 

MS Access database file for convenient data retrieval and 

analysis in the future. 

 

HandScan provides the following benefits: 

 Automated hand measurement. HandScan provides an 

automated, simple, cost-effective and systematic approach to 

obtain accurate and consistent hand measurements. 

 Anthropometric Survey support. HandScan is an ideal tool to 

obtain fast and reliable hand dimensions in large-scale 

anthropometric surveys. 
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2. System Installation 

 

The HandScan product comes in one of two configurations: 

1. A system equipped with a computer and a scanner 

2. A system equipped with a scanner 

 

If your product is equipped with a computer and a scanner, you do 

not need to read this chapter. The HandScan software has been 

installed, and the computer configuration has been optimized. 

 

If you product is equipped with a flatbed scanner, the instructions 

in this chapter have to be carefully followed in order for HandScan 

to function correctly. 

 

Computer Requirements 

 

In order to install and use HandScan, make sure your computer 

meets the following minimal requirements: 

 Operating System: Windows 98/ME/2000/XP 

 Free Disk Space: 10 MB + 0.5 MB for each hand 

measurement 

 Memory: 128M 

 Connection: USB 

 

Installation 

HandScan v2.1 uses a specific flatbed scanner to acquire hand 

data. This scanner should be installed in order for HandScan to 

function correctly, even if you already have a scanner in use. The 

following instructions will guide you through the installation 

process. 
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1. Insert the HandScan v2.1 installation CD into the CD-ROM 

drive. 

2. Launch Setup.exe from the directory Scanner Driver and 

follow the InstallShield Wizard to install the scanner. 

3. Launch Setup.exe from the CD root directory. Follow 

HandScan v2.1 Setup Wizard to install HandScan software. 
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3. Using HandScan 

 

Starting and Exiting HandScan 

 
To start HandScan, double-click the HandScan icon on the 

desktop. The main program interface of HandScan v2.1 is shown 

in Figure 1. 

Note: In order for HandScan v2.1 to function correctly, certain 

system files might need to be updated. If so, the following 

error message will appear: “Missing export 

msvcrt.dll:_lc_collate_cp”. To solve this problem, please refer 

to either the trouble-shooting chapter in this manual, or the 

ReadMe.txt file in the HandScan Installation CD.  

 

 

Figure 1. The main interface of HandScan 
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Note: All the screenshots in the current manual represent the 

program interface when running under the MS Windows 2000 

operating system. If you use another operating system, the 

appearance may be slightly different. 

Only one instance of HandScan application should be used at a 

time on a computer. If you try to run multiple HandScan 

applications on a single computer simultaneously, HandScan will 

not function correctly. 

To exit HandScan, select the File menu item, and click Exit. 

HandScan application window will be closed. 

HandScan uses the standard user interface for MS window 

programs. In addition to the methods described above, HandScan 

can also be started and exited by other common methods. 

Scanning a Hand  

1. Make sure the scanner is connected to your computer 

correctly, and power supply is connected to the scanner. 

2. Enter data from the main interface, including Name, Gender, 

and additional Notes. This information is optional to scanning 

and measuring a hand. It will be shown in the measurement 

report and/or be stored in a database file for further use. 

3. Prepare to acquire a hand image. 

a. Remove all rings and hand accessories. 

b. Put the hand on the scanner and spread open the fingers, 

especially the thumb. Place your palm and fingers 

entirely within the scanning area. Make sure to spread the 

thumb as far as possible.   

c. Place the wrist and forearm on the scanning surface so 

that the wrist in the picture is clear. 

4. When you are ready to scan, press the Scan button in the 

main interface or select Acquire Image submenu item from 
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   Figure 2. Sample hand position 

the File menu. Do not move your hand while scanning is in 

progress. 

5. When scanning is completed, the Process button in the main 

interface will be activated. Meanwhile, your hand image will 

appear in the main interface. Now, you can remove your hand 

from the scanner. 

6. If the acquired hand image is unsatisfactory, the above 

scanning process can be repeated as many times as needed.  

Note: Please check that 

your hand is positioned 

similarly to the one in 

Figure 2. Otherwise, repeat 

steps 3 through 5 until you 

get a correct image. 
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Calculating Hand Measurements 

 

After a hand image is acquired, the system can proceed with 

calculating nine (9) hand measurements. 

1. Press the Process button in the HandScan main interface to 

calculate the hand dimensions from the image acquired. If the 

program finds the image unsatisfactory, a warning message will 

appear. Press OK and then press the Scan button again to 

reacquire the hand image. 

2. When the image is processed correctly, the obtained hand 

measurements are displayed in the main interface. They include 

nine hand dimensions: hand length, palm length, hand breadth, 

middle finger width, and five finger lengths. You can click the 

“Value” list bar header to switch units between inches and 

centimetres.  

Figure 3. Hand image has been processed. 
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3. The text in the lower left corner of the image indicates whether 

the left or right hand was measured. A sample screen after 

processing is shown in Figure 3. 

4. Color contour and Measurement lines also become available for 

display after processing. (Refer to Customizing Image Display, 

Chapter 3). 

HandScan v2.1 provides nine hand measurements, of which 

second digit length, third digit length, fourth digit length, third 

digit width, and hand breadth are calculated with superior quality. 

 

Scanning a New Hand Image 

 

To prepare for new hand measurements, press the Next 

button from the HandScan main window, and repeat the steps 

in the preceding sections. 
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Printing Measurement Report 

 
After the hand image has been processed, you can print a report 

containing hand measurement information. Select the File pop-up 

menu from the main menu, and choose the following categories: 

1. Print Setup... to select printer and paper size. 

2. Print Preview to preview the report. 

3. Print to finally print the report.  

A sample measurement report is shown in Figure 4. 

 

 

Figure 4. Measurement Report 
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Retrieving and Deleting Measurements 

 

Hand measurements and the corresponding personal information 

are stored in the HandScan program. You can retrieve them to 

view the hand images and calculated dimensions, to scan new 

images for the same person, or to delete records. 

 

1. From the File pop-up menu, choose the Retrieve 

Measurements option. The Retrieve Measurements dialog box 

will appear (see Figure 5) containing a list of recent 

measurement records. Records include five fields: Hand ID, 

Name, Date, R/L hand and Notes. 

 

Figure 5. Retrieve Measurements Dialog Box 

 

2. Clicking one of the column headers will set the sorting 

criterion for the records. 
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3. You can retrieve one record at a time. To do so, either double-

click corresponding line or select the record and then press 

Retrieve Data. The information about the record selected will 

be displayed in the main window. 

4. To delete one of the records from the list, select it and then 

press Delete Data. The record will be permanently erased 

from the memory. 

5. To return to the main window, press Close. 

 

Exporting Hand Data to Access 

Database 

You can also transfer the measurement data to an “MS Access” 

database file that can be used in further calculations. 

1. From the File menu, choose the Export Database item. 

2. In the File dialog box, find the directory where you want to 

save the database file, enter the file name, and then press Save. 

3. If you have MS Access installed, you will be able to browse 

the file created. To do so, choose Yes from the message box 

offering to open the exported file. Press No to return 

immediately to the main interface. 
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Customizing Image Display 

 

You can use the View Menu to select the image information you 

want to display on the screen. The following options are available: 

Color Image, Contour and Measurements. 

 

 Color image refers to the original image acquired from the 

scanner; 

 Contour outlines the shape of the hand; 

 Measurements show how hand dimensions were calculated. 

 

At least one of the three options should be selected. 

 

Figure 6 gives samples of different image display settings 

      

Contour   Contour +       Contour +  
Color image measurements 
 

Figure 6. Samples of different display settings 
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4. Troubleshooting 

 
HandScan was designed to be a reliable tool with a long-term field 

life. If you are experiencing difficulties with it, check the 

following possible solutions.  

 

Problem Probable Cause Solutions 

Scanner is not 

available 

 The driver of the 

provided scanner 

is not installed 

 Install TWAIN 

driver from 

HandScan 

installation CD 

 USB cable or 

scanner power 

supply are not 

connected 

 Connect the cables 

Image can not 

be processed 

 There is no hand 

in the picture 

 Acquire an image of 

a hand 

 Some of the 

fingers touch each 

other 

 Spread the fingers 

apart 

 The hand is too 

dark in the image 

 Keep the hand clean. 

If the skin color is 

dark, cover the hand 

with a light glove 

 The background is 

too bright  

 Keep the scanner 

covered with the lid 

while acquiring 

images; clean the 

scanner surface to 

reduce light 

reflection 
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Problem Probable Cause Solutions 

 No hand 

measurements 

available 

 Scan and process new 

hand image, or 

retrieve a hand 

measurement from 

Retrieve 

Measurements dialog 

box 

Hand 

measurements 

are not accurate  

 Dirty scanner 

surface 

 Keep the scanner 

surface clean 

 Long fingernails: 

overall finger 

length calculated 

by HandScan 

includes nail 

length 

 Cut the fingernails 

 Incorrect hand 

position 

 Acquire a hand 

image using the 

correct hand 

position. See the 

section Scanning a 

Hand for details 

Measurement 

report can not 

be printed  

 No printer 

connected 

 Connect a printer 

Program is not 

responding 

 Scanner has been 

disconnected 

during scanning 

 Restart the computer 

“Missing 

export 

msvcrt.dll:_lc_

collate_cp” 

error message 

 System file 

MSVCRT.DLL 

needs to be 

updated 

To update this system 

file under 

MS Windows 98 use 

System File Checker 

(SFC). 

1. Choose Run from 

the Start menu at the 

taskbar; enter SFC in 
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Problem Probable Cause Solutions 

the input field; press 

OK. 

2. Select "Extract one 

file from installation 

disk" in the System 

File Checker 

window. 

3. In the "File to 

extract" box, enter 

MSVCRT.DLL; 

press Start. 

4. In the "Restore 

From" box, enter the 

folder where 

HandScan is 

installed.  

5. In the "Save file in" 

box, enter the system 

folder. For 

Window98, it is 

C:\Windows\System 

6. Press OK, and then 

press Close to restart 

the computer. 

Warning! Do not modify any files in the HandScan program folder. 

When configuration files are corrupted, the HandScan program will 

not function properly. Reinstalling the HandScan program will recover 

the correct configuration files, but the reinstallation will also destroy all 

the hand data previously scanned and calculated. 

If the problem persists, please contact Customer Support at VisImage 

Systems Inc. 
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5. Where to Get Help 

You can get help regarding your HandScan system from the following 

five sources: 

1. Refer to the HandScan User’s Manual 

2. Consult your IT personnel/system administrator 

3. See HandScan built-in Help function 

4. Visit the VisImage Systems Inc. website 

5. Contact a VisImage Systems Inc. representative 

Your IT Personnel 

 

Consult your system administrator if you have questions about certain 

configurations of your computer (refer to System Setup, Chapter 2). 

 

Built-in Help 

 

HandScan has a built-in context-sensitive help manual. You can 

conveniently consult it while using the program. 

 

Website 

 

For more information, visit the HandScan product home page at 

http://www.vis.ca/handscan.htm 

 

Customer Support 

 

If you have questions concerning the operation of HandScan, you may 

contact VisImage Systems Inc. customer support. E-mail your 

questions to: support@vis.ca, or send them by fax to +1-905 946 1060. 

A customer service representative will reach you within 24 hours. 

 

http://www.vis.ca/handscan.htm
mailto:support@vis.ca
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If you want to speak to us directly, please call 1-905-946-0000. Within 

the U.S. and Canada, a toll-free number is also available: 

1 866 VIS 4624 (1-866-847-4624). 

Contact address: 

VisImage Systems Inc. 

7676 Woodbine Ave. Suite 14 

Markham, ON, Canada 

L3G 2N2 

 


